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Abstract

Key points

Volume electron microscopy is the method of choice for the in situ
interrogation of cellular ultrastructure at the nanometer scale, and with the
increasein large raw image datasets generated, improving computational
strategies forimage segmentation and spatial analysis is necessary. Here we
describe a practical and annotation-efficient pipeline for organelle-specific
segmentation, spatial analysis and visualization of large volume electron
microscopy datasets using freely available, user-friendly software tools that
canberunonasingle standard workstation. The procedures are aimed at
researchersin the life sciences with modest computational expertise, who use
volume electron microscopy and need to generate three-dimensional (3D)
segmentation labels for different types of cell organelles while minimizing
manual annotation efforts, to analyze the spatial interactions between
organelleinstances and to visualize the 3D segmentation results. We provide
detailed guidelines for choosing well-suited segmentation tools for specific
cell organelles, and to bridge compatibility issues between freely available
open-source tools, we distribute the critical steps as easily installable
Album solutions for deep learning segmentation, spatial analysis and

3D rendering. Our detailed description can serve as areference for similar
projects requiring particular strategies for single- or multiple-organelle
analysis, which can be achieved with computational resources commonly
available to single-user setups.
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e This protocol provides a
pipeline for analyzing volume
electron microscopy datasets
covering the preparation of

raw data, the segmentation of
specific organelles, their spatial
analysis and three-dimensional
visualization of the segmentation
maps.

e The protocol demonstrates the
use of tools such as Microscopy
Image Browser, ilastik, Labkit
and Album, which facilitates

the installation of Python-based
software (CSBDeep, CellSketch,
StarDist, Blender and Jupyter
notebooks).
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Introduction

For several decades, two-dimensional (2D) electron microscopy (EM) has been used to
study the intricate details of subcellular components, contributing to key findings in cell
biology and medicine. Inrecent years, three-dimensional (3D) volume electron microscopy
(VEM) has established itself as a widely adopted new imaging modality, leading to a rapid
proliferation of large raw image datasets of cells and tissues'’. vVEM includes methods such as
serial section transmission electron microscopy (ssTEM), serial section electron tomography,
serial block-face scanning electron microscopy (SBF-SEM) and focused ion beam scanning
electron microscopy (FIB-SEM). The recent popularity of vVEM has been made possible by
major advances in sample preparation®* as well as substantial improvements in stability and
enhanced running time of instruments®, resulting in impressive advances in connectomics™*°
aswell as in cell biology/biomedicine' ™, and even enabling the reconstruction of whole
organisms®°. Moreover, many of these datasets have been made publicly availablein
open-access repositories/platforms such as EMPIAR?, CEM500K** and OpenOrganelle®.
The massive increase in data generation and accessibility hasled to a surge in demand for
analysis approaches. In particular, this requires segmentation maps of the desired structures
throughout the volume followed by analysis of, i.e., volume fractions and/or investigation
of spatialinteractions. Until recently, amajor part of the segmentation work had to be done
manually within software packages such as IMOD?*, which can become extremely time
consuming or even infeasible for larger datasets. Nevertheless, these approaches have led
toimpressive results>*,
Therise of machine learning methods has increased the possibility for automatic

segmentation processes of a diverse set of organelle classes in large VEM images??" 2,
For example, Kaynig et al.” used random forest classifiers® to semi-automatically segment
neurons from ssEM images. More recently, deep learning-based approaches based on U-Net**
have shown impressive results on large-scale organelle segmentation from FIB-SEM volumes,
as part of the Cell Organelle Segmentation in Electron Microscopy project®, allowing
pixel-wise segmentation for up to 35 cellular organelle classes. However, deep learning-based
methods typically rely onlabor-intensive manual ground truth annotation efforts, and often
require computational resources that smaller laboratories cannot afford. Furthermore,
the bioimaging community currently lacks protocols dealing with spatial analysis of 3D
segmentation maps, such as the distribution of organelle distances, which prevents full
exploitation of the raw data to obtain new biological insights. Finally, an effective visualization
of the obtained volumetric segmentation maps is crucial for a holistic understanding of
organelle distribution. At the same time, the fragmented landscape of visualization tools,
that are often hard to learn, can be confusing for inexperienced users. In this protocol, we aim
toaddress these issues by providing practical guidelines to perform the following key tasks
onvEM images:

 Preparation of raw data (Procedure 1)

 Organelle-specific segmentation with a various set of methods (Procedure 2)

- Spatial analysis of the segmentation maps (Procedure 3)

 3Dvisualization of segmentation maps (Procedure 4)

We present detailed steps for the segmentation of vEM datasets with user-friendly tools

and give recommendations for which methods are most appropriate for each organelle
class. We furthermore provide detailed steps to analyze the spatial interaction between the
resulting 3D segmentation maps, thus enabling acomprehensive view of intracellular organelle
interactions, which is essential for understanding the complex cellular ultrastructure. Finally,
we present detailed instructions for generating 3D visualizations of the segmented organelles
within their native cellular context and for creating accurate renderings for publication
purposes and scientific outreach. Although these procedures were originally designed to
be applied within a single project, we note that each procedure is modular and canbe run
independently given the availability of appropriate input data.
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Development of the protocol

Weinitially developed this protocol (Fig. 1) to investigate the interaction of microtubules and
organelles in quasi-isotropic FIB-SEM volumes of primary beta cells with a voxel size of 4 nm
(ref.11). Our aim was to analyze several complete beta cells in samples exposed to different
metabolic stimuli (glucose concentrations). We focused on the organization of microtubules,
theirinteraction withinsulin secretory granules (SGs) and other organelles, as well as possible

1. Preparation of raw data

2. Segmentation
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Fig.1| Overview of the protocol. Workflow starting with vEM data followed by via Album. Raw data and analysis image adapted from ref. 11, under a Creative
organelle-specific segmentation, spatial analysis of the dataand 3D rendering Commons license CC BY 4.0.
of the results. Analysis, plotting and 3D rendering steps can be performed
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changes upon stimulation with glucose. This required performing 3D segmentation of various
organelles such as microtubules, insulin SGs, nuclei, centrioles, mitochondria, Golgi apparatus
and the plasma membrane of each cell. These organelles strongly differ in many of their
features: abundancein the cell, shape and electron contrast. Since some of them, such as the
insulin SGs, amount to several thousand vesicles per cell, it became clear to us that full manual
annotation is too time consuming and cumbersome. We also found that no single segmentation
approach would perfectly match the specific features of all organelles simultaneously, and
therefore chose dedicated methods that best suited a given organelle. Specifically, we required
(i) mostly automated segmentation approaches that (ii) do not demand a large computational
infrastructure and labor-intense prior annotation, can be (iii) implemented in user-friendly
software and (iv) export file formats for segmentation results that can be easily shared between
collaborators.

We used Microscopy Image Browser (MIB)* for manual segmentation of the plasma
membrane and local thresholding of centrioles and nuclei. For more abundant and structurally
conspicuous organelles such as mitochondria and (in a first attempt) insulin SGs we used
autocontext classification®® implemented in ilastik®%. For more difficult tasks such as the Golgi
apparatus, we turned to deep learning using a U-Net architecture®* implemented in CSBDeep?’,
whereas for refinement of insulin SG segmentation masks we used StarDist*’. For full manual
tracing of microtubules, we chose Knossos* since it allows memory-efficient annotation at
the native pixel resolution, which is crucial for microtubules. Finally, manual curation of the
segmentation results was performed in ilastik or the Labkit plugin**in Fiji*.

We also found that amajor hurdle for the proper analysis of 3D segmentation masks was the
lack of protocols describing the analysis of complex spatial interactions. Analysis of organelle
volumesis, e.g., possible inilastik, IMOD or with the 3D object counter in Fiji**. However,
high-resolution vEM segmentation masks enable the inspection of spatial interactions between
organelles. This becomes especially interesting when investigating cells or tissues under
different metabolic conditions, as in our case" and in other instances, or when comparing
states in health and disease*. We therefore have devised a series of steps to perform these
analyses, which helped us to unravel the connectivity of microtubules to centrioles and the
Golgiapparatus as well as their close interaction with insulin SGs.

The final step was the 3D rendering of the segmentation results for publication purposes
and scientific outreach. For 2D overlays of raw and segmentation data we used the Fiji plugin
3Dscript*®, which can also be used to generate 3D animations. For more engaging animations
with shadows and special surfaces, we used Blender (https://www.blender.org/), which makes it
necessary to convert the binary segmentation masks into meshes. This enables the generation
of complex videos for public outreach.

Expertise needed toimplement the protocol

This protocolis aimed atimaging scientists in biology and medicine with medium-level
computational expertise who want to analyze vEM datasets of cells, tissues or small organisms.
Itisadvantageous for users to be familiar with cellular ultrastructure as well as with the most
widely distributed bioimage analysis tools, such as Fiji, ilastik and MIB. To help users to run
Python/scripting-based tools in our workflow, we distribute them as Album solutions that
streamline the process of dependency installation and allows users to execute workflows as
installable graphical user interface (GUI) components.

Advantages, applications and comparison with other methods

Instead of relying on a single software, we provide amodular open-access workflow that enables
users to pick out single methods for segmentation, analysis and rendering depending on their
project. In contrast to multi-organelle segmentation approaches that use deep learning for all
organelle classes, and thus rely on the creation of massive amounts of user-annotated ground
truth for all organelles, our pipeline judiciously chooses organelle-specific segmentation
methods to reduce unnecessary annotation effort. This strategy enables to achieve reasonable
results early in the project for certain organelles, so that more time can be spent on difficult
segmentation tasks. Nevertheless, the modularity of our approach allows users to still
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incorporate their preferred segmentation tools. Integration of spatial analysis and 3D rendering
into easily executable, interactive solutions with Album*’ allows users to best address complex
organelle interactions within cells and to obtain novel biological insights from their vEM
datasets. Furthermore, we provide a simple yet effective Blender workflow that enables the
complete inner life of cells to be visualized in 3D that augments common perceptions derived
fromonly 2D images.

The use case that we primarily address in this protocol is organelle segmentation in
FIB-SEM volumes of beta cells. However, we designed the segmentation, analysis and
rendering workflows in away that allows the simple adaptation to other cell types and vEM
modalities. Possible research questions include investigating the interaction of organelles with
microtubules, contact sites between organelles such as mitochondria and the endoplasmic
reticulum (ER), and changes in organelle morphology and interactions under different
metabolic stimuli or disease conditions. We also aim to help scientists to decide which
segmentation workflow suits their target structure best and to find a time- and labor-efficient
strategy. We originally developed the protocol for analysing isotropic FIB-SEM volumes
containing complete cells. However, most of the presented methods can also be applied to
anisotropic datasets derived from ssTEM or SBF-SEM imaging or smaller volumes comprising
only afew serial sections or single tomograms. Due to its modular design, our approachis
complementary to other vVEM segmentation and analysis tools (e.g., Amira, Empanada*®,
workflows provided by ZeroCostDL4Mic*’, pretrained models of the Biolmage Model Zoo*°)
asthese canbeintegrated in our protocol at the appropriate steps. Therefore, our strategy
canserve as a time- and labor-efficient framework for vEM analysis.

Limitations

Currently, we do not present strategies for all organelle classes such as ER, endosomes or
lysosomes. Time-efficient tools to segment these structures as well as alternative programs,
which could be implemented into our workflows, are described in the next paragraph.
Additionally, the completely manual annotation of microtubules presented in our protocol is
currently very time consuming and poses a bottleneck for our project. There are approaches
using template matching® or deep learning>’ that might help to automate this task in the
future. Furthermore, vesicle segmentation with StarDist should work similarly well for other
large dense core vesicle types whose ultrastructure resembles SGs (e.g., chromaffin granules).
For other, more distinct vesicle types (e.g., synaptic vesicles) alternative approaches, such as
inref. 53 might be more appropriate.

Our protocol was tested on quasi-isotropic FIB-SEM data, and therefore some of the
segmentation tools described might work less well for anisotropic data modalities such as
ssTEM or SBF-SEM. There it might be necessary to switch to tools developed specifically for this
type of data, such as CDeep3M (ref. 54), which can be included into our workflows.

Finally, our current data format (TIFF) for exporting most of the segmentation results
is suboptimal since it does not allow for very efficient saving and reading of the data. Hence
switching to hierarchical data-formats (e.g., Hierarchical Data Format 5 (HDF5) (ref. 55),

N5 (ref. 56) or ZARRY) will be beneficial in the future (with the caveat that not all segmentation
tools currently support these formats). Therefore, we only used HDF5 for segmentationin
ilastik and kept TIFF for the other segmentation tasks. As a result, our workflow might struggle
for excessively large VEM datasets as used, e.g., in connectomics. However, we use amodern
hierarchical dataformat (N5) for the spatial analysis and plan to integrate these data formats
more consistently in the future. Finally, designing interactive workflows with interconnected
components that fully operate on hierarchical data formats would be beneficial forimproving
the scalability of the protocol.

Alternative tools

Thefield ofimage segmentation is progressing rapidly, especially due to the rise of deep
learning-based methods. However, to our knowledge, there are no freely available tools that
combine various segmentation approaches as well as analysis and visualization workflows.
Inthe following, we highlight alternative and complementary tools for segmentation of VEM
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datathat we believe show a high potential for facilitating this workflow, although they may

require more advanced computational skills. Tools such as SURV0oS***° aim to combine manual
with machine-learning segmentation to facilitate image annotation. Pretrained models

such as MitoNet*® hold great potential for facilitating segmentation tasks by eliminating the
requirement of the generation of training data. Empanada, the associated napari plugin for instant
segmentation of mitochondria, provides rapid segmentation results. As an alternative to CSBDeep
U-Net, segmentation can be performed with DeepMIB®° as part of MIB or deep learning-based
approaches such as ASEM*. Furthermore, there are various ways to reduce the annotation effort
for ground truth generation e.g., such as described in CebraEM®. Also, approaches such as ‘Etch
acell®* involving volunteers for ground truth generation have been implemented successfully,
e.g., for segmentation of the nuclear envelope™. For spatial analysis of organelles, there are
currently only a few tools available including Neuromorph add ons®*“* for Blender as well as
Barrios® developed for the investigation of spatial interactions within neuronal tissue.

Experimental design

In this section, we give some methodological background to the four main subtasks that we
describeinthe protocol: raw data preparation, organelle segmentation, spatial analysis and
visualization (summarized in Table 1).

Organelle segmentation

Atthe beginning of each vEM analysis project, it is pivotal to decide which organelles need to

be segmented and which kind of interactions need to be analyzed to solve the specific scientific
question (Box 1 and Fig. 2). We recommend a series of tools for segmentation of different
organelle types. However, using all of these in a single project is still time consuming and, in many
cases, information of most of the cell’s organelles may not be fully necessary. Before beginning to
annotate structures, itisimportant to have an overview on different methods and to decide which
strategy might fit best the organelle to be segmented. We list segmentation strategies according
to organelle features (Fig. 2), which helps decide which method to use; Table 2 summarizes the
specific practical advantages of the software packages we chose for segmentation.

Semi-automatic local thresholding and manual segmentation. For some organelle classes
withlow abundance (e.g., centrioles) segmentation via locally adjusted thresholding at each
instance can already be sufficient and at the same time relatively quick to perform. Local
thresholding works by manually segmenting the area very close to the target organelle followed
by black-and-white thresholding within this defined area. We use this strategy for nuclei and

Table 1| Overview of the procedures, their content and their mode of installation

Task Steps Tool Installation
Preparation of raw data Binning/cropping of EM data Fiji GUI
(Procedure 1) Conversion into software-specific formats Knossos cuber, Fiji GUI
Segmentation Local thresholding MIB GUI
Pregseiies Random forest classifier ilastik GUI
Deep learning/U-Net segmentation CSBDeep Album
Shape-aware Deep learning StarDist Album
Spatial analysis Creating a new CellSketch project accumulating CellSketch Album
(Procedure 3) segmentation results
Computation of spatial statistics CellSketch Album
Visualization of spatial statistics CellSketch Album
Plotting spatial statistics Jupyter Notebook Album
(Python)
Visualization Conversion of segmentation masks to meshes VTK (Python) Album
(Procedure 4) Inspection of meshes VTK (Python) Album
3D rendering Blender Album
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BOX1
How to choose a segmentation method

Different organelle classes pose different challenges to an automatic segmentation method: a method
that accurately segments mitochondria might not be a suitable choice for delineating the Golgi
apparatus, and vice versa. Knowing which segmentation method is best suited for each organelle
class is thus critical for both the accuracy of the final results and to avoid time-consuming annotations
in cases where they would not be required. In general, this choice depends on structural features of
the organelle such as typical image contrast, organelle abundance and morphological complexity.
Rare and contrast-rich organelles such as centrioles or nucleus, for example, often can be segmented
with relatively simple tools that do not require manual annotation effort, such as local thresholding.
On the other hand, abundant but well separated organelles, such as mitochondria, typically are best
segmented with machine learning-based methods such as random forests or CNNs, which in turn
require a certain amount of manual annotations. For this class of organelles, we recommend starting
with random forest classifiers (such as provided by ilastik) that enable quickly judging whether

more advanced methods such as a U-Net based semantic segmentation with CNNs are required.
Finally, some organelle classes may present unique challenges, such as the extreme dense and
crowded distribution of SGs that are hard to properly separate. For such situations, problem-specific
applications might exist, such as the shape-aware method StarDist for the detection of crowded
spherical objects. In Fig. 2 we summarize our choice for manual, semi-automated or machine
learning-based segmentation tools, which we used in our FIB-SEM project”. This shall serve as an
inspiration for any new segmentation endeavor.

centrioles, and chose MIB as a tool as it makes it possible to export segmentation resultsin
various formats, such as an Amira AM file or TIFF. For other classes (e.g., plasma membrane)
such simple approaches might fail to detect the structure of interest, and laborious manual
segmentation might become necessary. Manual segmentation is basically done by tracing the
outlines of the target organelle with a pen or brush tool in every z-section of the stack. It can be
facilitated by interpolation in the z-dimension every five or ten slices. We again used MIB for
manual segmentation of the plasma membranes of the cells.

Random forest segmentation. Random forest-based segmentation methods***° use an ensem-
ble of decision trees to classify each pixel based on a set of predefined image features. Random
forest classifiers need only sparse (e.g., scribble) annotations and are fast to train, making

Organelle features Example Segmentation strategy Organelle complexity  Annotation effort
- Low occurence-small ROI Centrioles, Manual + semi-automatic, Low Low
- High contrast nucleus local thresholding (MIB)
- Low complexity
- High contrast Mitochondria Sparse labeling,
- Low complexity random forests (ilastik)
- High occurence
- High complexity Golgi, ER Deep learning,
- High convolution U-Net (CSBDeep)
- High occurence Vesicles Shape-aware deep learning,
- High densitiy (StarDist)
- Low contrast Microtubules Manual skeleton tracing
- Expert knowledge required (Knossos) ) )
- Precise segmentation required High High

Fig.2|Overview of segmentation approaches on beta cell FIB-SEM datasets. Different organelles have characteristic features that should be considered when

deciding on a segmentation approach. This enables the choice of time- and workload-efficient strategies.

Nature Protocols | Volume 19 | May 2024 | 1436-1466

1442


http://www.nature.com/NatProtocol

Protocol

Table 2 | Tools for specific segmentation strategies with their features that are beneficial
for the segmentation task

Segmentation strategy Tool Important software features Organelle Procedure 2
steps

Local thresholding and MIB Local thresholding, interpolation, Membrane, nucleus  1-13

manual segmentation export to various formats

Random forests ilastik Fast learning based on sparse Mitochondria 14-32

labeling, iterative improvement
through the Autocontext feature

Deep learning CSBDeep Able to segment highly convoluted ~ Golgi 33-52
and complex structures

Shape-aware deep StarDist Prediction of polyhedral shape SG 53-58

learning approximations for each object

Manual skeleton tracing Knossos Memory-friendly data handling Microtubules 59-64

them the classical machine-learning method of choice for initial segmentation experiments
without the need for excessive manual annotation. Several software packages, such as MIB,

Fiji (with the plugins trainable weka® or Labkit*?) and ilastik provide random forest classifiers.
llastik additionally implements a cascaded random forest classifier (‘autocontext’), which can
achieve better results than the simple pixel classification but includes two rounds of annota-
tion and training. In the first round, the user needs to annotate many different organelles (e.g.,
nucleus, vesicles, mitochondria, ER, Golgi, ribosomes). After training, only the background and
one organelle (e.g., mitochondria) are labeled. The second round of training will enable better
results compared with a single-step pixel classification. We used this approach for segmentation
of mitochondria and to generate ground truth data for insulin SGs and the Golgi apparatus.

Deep learning. Deep learning based on multilayered convolutional neural networks (CNNs)

has become the most prevalent method for challenging image segmentation problemsin the
life sciences®®. Commonly used CNN architectures can capture high- and low-resolution image
semantics while containing millions of parameters that are learned from training data without
the need for handcrafted features. Although this can resultin very expressive and powerful
segmentation models, the amount of training data required for good segmentation results is
typically larger than for less expressive methods (e.g., random forests), and thus the manual
annotation effort is often the bottleneck in those workflows (Box 2). The most widely used archi-
tecture for microscopy image segmentation is U-Net**. Moreover, network ensembles also have
led to good results®**°,

Shape-aware deep learning. For some organelle classes, it can be beneficial to exploit the
structural priors they might possess, e.g., for SGs or other vesicles that are typically spherical in
shape. Inthese cases, shape-aware deep learning methods that directly incorporate these priors
in their prediction targets can be effective. Examples of these include StarDist*°, SplineDist™,
Cellpose” or local shape descriptors’.

Skeleton tracing of filamentous structures. Components of the cytoskeleton such as microtubules
are filamentous structures that can be represented as skeletons with a defined thickness.

Since microtubules have an outer diameter of 25 nm, it was in our case necessary to use the full
resolution of the dataset for annotation. Knossos uses a special file format, enabling the loading

of only asmallregion surrounding the currently viewed area which makes it very memory efficient.
Skeleton tracingis then performed by going through the volume and setting points throughout
single microtubules from start to end, which are then connected by aline. These skeleton traces
arethen analyzed with adownstream procedure that we make accessible via Album.

Volume and spatial analysis
Analysis of the segmented data usually starts with calculating volumes and volume fractions
of the different organelles with respect to the whole cell or raw volume. These calculations

Nature Protocols | Volume 19 | May 2024 | 1436-1466 1443


http://www.nature.com/NatProtocol

Protocol

BOX2
How to generate ground truth

Machine learning-based segmentation methods (such as random forest and deep learning) require
training data that consists of raw images and corresponding annotations (ground truth). For most
random forest methods, sparse (scribble) annotations are sufficient for good segmentation results,
whereas many deep learning-based segmentation methods require fully labeled ground truth images.
As typically only a small part of the full raw images can be annotated with reasonable effort (e.g.,

5-10 subregions of 128 x 128 x 128 pixels), the selection of which subregions to annotate is crucial for
the performance of the trained model. These subregions should cover as best as possible the image
variability seen in the full dataset. That means that you should not exclusively provide labelings of your
organelle of interest, but also regions without it, such as extracellular space or regions rich in other
organelles/structures. We also advise to label several small crops of the raw data and not a large chunk
of the dataset. One should cut several small structurally diverse volumes ideally out of several raw
datasets to ensure a good final segmentation result. To generate proper ground truth, a high level of
expert knowledge is necessary. Classic EM textbooks and recent publications such as ref. 90 can help
to decide how to distinguish organelles. As the generation of pixel-accurate annotation masks from
scratch can be quite time intensive, we generally recommend creating preliminary ground truth with

a fast and easy to use method first (e.g., ilastik) and then refine and curate them manually in a second
step. This way, most of the annotation effort is spent on hard structures and facilitates the process of
ground truth generation as well as enabling non-expert users to more quickly understand the structural
features of the different organelles.

can be performed by several image analysis programs such as IMOD, Fiji, MIB or Amira.
These data help to address the heterogeneity between cells and to investigate changes

in organelle volumes, i.e., upon metabolic changes or in disease conditions. Precise
segmentation masks also allow the analysis of distances between organelle classes either
directly out of the binary masks or after creating 3D meshes. These approaches were first
established for analyzing microtubule interactions in electron tomograms of mitotic
spindles” and organelle interactions within the Golgi region of a beta cell line’. The latter
study also introduced the comparison between observed and random distributions to make
assumptions onregulated processes of organelle interaction, amethod we have adopted
for our original study. These kinds of calculations enable the investigation of complex
interactions between organelles and the definition of subsets of an organelle based on

its connectivity. Tools are partially implemented in IMOD, Amira and in the Neuromorph
toolset for Blender®*®*; however, they are not yet widely adopted. We generated distance
transformations to calculate distances and connectivity between organelles with Image]J2
(ref. 75) and ImgLib2 (ref. 76). Processing and plotting of these data were performed with
Python-based tools’~%. In this protocol, we facilitate installation and execution of interactive
workflow steps with Album.

Visualization

Asuccessful 3D segmentation allows 3D rendering of the generated organelle masks to visualize
alloraselection of organellesin their proper context (Box 3). Several tools are available that
enable direct rendering of the original masks such as the 3D viewer® or 3Dscript* in Fiji orin
Object Research Systems (ORS) Dragonfly. Dedicated 3D software tools such as Blender usually
require conversion of the binary masks into 3D meshes. Before starting the 3D visualization,
you should define a color scheme for your organelles with the help of online tools such as
https://coolors.co/. ldeally, this should be colorblind friendly or at least structurally similar
organelles such as different vesicle types should have distinct colors. You can check this with
the Simulate Color Blindness plugin in Fiji.
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BOX3
How to effectively visualize results

As an integral part of basic research in medicine, biomedical image datasets can establish links to
personal experiences of individuals with health or diseases. The 3D modeling and rendering software
Blender is exceptionally well suited to tell the story behind a 3D dataset. Blender is extremely versatile
within and beyond object material adjustment, illumination and animation. It is open source, freely
available and fully scriptable, enabling us to simplify complex routines such as importing specific
formats, adjusting the camera to frame all imported objects and assigning materials to the objects
automatically. Scientific images are usually represented as pixel data—as a grid of points where

each point has a specific value. To import such data into Blender, it first needs to be converted into

a geometric structure by distinguishing between background and foreground pixels and generating
a mesh of vertices along the border of the foreground, representing an object in 3D. Our protocol
includes a routine for this purpose.

Materials

Equipment

Hardware requirements

As minimum requirements for raw data handling, segmentation and 3D visualization

(Procedures 1,2 and 4) we recommend a computer with:

1. Atleast16 GB random-access memory (RAM)

2. AnNVIDIA graphics processing unit (GPU) with at least 4 GB RAM

3. Anup-to-date operating system (Windows 10/11, OSX 11+, Ubuntu 18+)

4. Atleast500 GB of storage space

For steps thatinvolve the training of deep learning models (Procedure 2), we additionally require

An NVIDIA GPU with atleast 8 GB memory

A working CUDA (>10) installation (instructions are available at https://docs.nvidia.com/

cuda/cuda-quick-start-guide/index.html#windows)

For the original study we used

7. ThinkPad P52 with 32 GB RAM and an NVIDIA Quadro P3200 GPU with 6 GB VRAM with
Windows 10

8. Workstation with128 GB RAM and an NVIDIA RTX 2080 with 8 GB RAM with Ubuntu 18.04
The analysis and visualization procedures were additionally tested on

9. Desktop computer with 32 GB RAM and an NVIDIA GeForce RTX 3060 with12 GB VRAM with
Windows 10

10. ThinkPad P14swith 48 GB RAM and an NVIDIA T500 with 4 GB VRAM with Ubuntu 20.04

11. MacBook Prowith 0SX12.3.1, with 32 GB RAM, M1 Max CPU/GPU

o wn

Datasets
12. Demo data (Table 3) to be used for individual steps of our protocol are available at
https://zenodo.org/record/8114392

Software

Standalone (GUI-based) software

Standalone software packages used in this protocol that are available as cross-platform
installable binaries and that can be executed viaa GUIl are listed in Table 4.

Album solutions
Several tools for segmentation, spatial analysis and visualization depend on custom python or
javascripts that canbe hard to install and execute (e.g., due to their dependencies). To facilitate
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Table 3 | Demo data for the procedures

Task

Type of data Link

Procedure1

FIB-SEM mouse 4 nm
resolution

Raw data for binning

https://openorganelle.janelia.org/datasets/jrc_mus-pancreas-1,

https://openorganelle.janelia.org/datasets/jrc_mus-pancreas-2

Procedure 2

FIB-SEM mouse 16 nm
resolution

Binned raw data for MIB/ https://zenodo.org/record/8114392/files/high_c1_source.tif

ilastik

FIB-SEM mouse 16 nm
resolution + masks

Training data for Golgi https://zenodo.org/record/8114392/files/data_golgi.zip

segmentation via
CSBDeep/Album

FIB-SEM mouse 16 nm
resolution + masks

Training data for https://zenodo.org/record/8114392/files/data_granules.zip

granule segmentation
via StarDist/Album

Procedure 3

Segmentation masks for
multiple organelles

Input for CellSketch

https://zenodo.org/record/8114392/files/high_c1.zip

Segmentation masks for
multiple organelles +
distance transforms

Input for spatial analysis https://zenodo.org/record/8114392/files/mycell.n5.zip

and visualization

Procedure 4

Input for rendering

n5 https://zenodo.org/record/8114392/files/mycell.n5.zip

installation and execution of these scripts, we wrap critical components into ‘Album solutions™’.

Album s adecentralized distribution platform for solutions to specific scientific problems.
Each Album solutionis a Python scriptincluding environment, custom installation routine
descriptions, and specific metadata and runtime argument specifications. It works across
platforms, tools and data domains and is designed to address limitations in reproducibility

of scientific data software solutions and workflows, particularly when interactivity is needed.
Allroutines in this protocol wrapped as Album solutions are bundled in an Album catalog and
canbeinstalled and launched from the GUI of Album. The Album documentation site (https://
docs.album.solutions/) provides information on how to install and use Album solutions. If you
runinto any issues when running the Album installation wizard or during solution installation,
refer to the Album troubleshooting page (https://docs.album.solutions/en/latest/faq.html).
Software run via Albumislistedin Table 5.

Table 4 | Standalone software used in this protocol

Tool Version Purpose Link
Fiji 2131 Software for bioimage visualization and analysis. https://imagej.net/software/fiji/
Here, we use several plugins for our workflow
Fiji plugins
Ilastik 1.8.3 Plugin for converting TIFF to HDF5 files in Fiji https://github.com/ilastik/ilastik4ij
and vice versa
Labkit 0.31 Plugin for annotation and random forest https://imagej.net/plugins/labkit/
classification. Here, we use it for annotation
and cleaning of ground truth data
ilastik 1.4.0 Software for image segmentation. Here, we use  https://www.ilastik.org/
it for segmentation with random forests
MIB 284 Software for segmentation of EM data providing  http://mib.helsinki.fi/
a large variety of tools. Here, we use it for
manual and local thresholding segmentation
of volume EM datasets
Knossos and v5.1 Software for opening and annotating large vVEM  https://knossos.app/, https://github.com/
Knossos cuber datasets. Here, we use it for skeleton tracing of ~ knossos-project/knossos_cuber

microtubules. KNOSSOS cuber converts volume
EM files to cubed files readable by KNOSSOS
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Table 5 | Software installed and executed via Album

Tool Version Purpose Link

CSBDeep 0.7.3 Toolbox for content-aware restoration of https://github.com/CSBDeep/CSBDeep
fluorescence microscopy images (CARE),
based on deep learning via Keras and TensorFlow.
Here, we use it for U-Net segmentation

StarDist 0.8.3 Object detection with star-convex shapes such as https://github.com/stardist/stardist/
nuclei or vesicles

CellSketch  0.21 3D toolbox for spatial analysis and visualization https://github.com/betaseg/cellsketch
of single cell organelle masks and labels

VTK 9.2.6 The Visualization Toolkit (VTK) is an open-source https://vtk.org/
software for manipulating and displaying scientific
data

Blender 3.31 3D computer graphics software tool for rendering, https://www.blender.org/

visual effects, motion graphics, 3D modeling, etc.

CellSketch

CellSketchis atoolbox of procedures for collecting volumetric annotations (e.g., organelles)
that are part of one object (e.g., a cell) in one project container, analyzing their spatial
relationships and rendering them jointly. Allimported data are stored in the N5 format as

hierarchical blocks, enabling smooth interactive visualization of the project in BigDataViewer.

Spatial analysis results between volumetric annotations are stored as tables. A routine for
generating plots based on the analysis in aJupyter Notebook is included. Finally, CellSketch
provides automated routines of exporting project annotations as meshes, displaying them
with VTK and rendering the project in Blender.

Procedure 1: preparation of raw data

A CRITICAL This protocol starts with an aligned vEM stack. Instructions on alignment
canbe found elsewhere®®, The voxel dimensions of the vEM stack need to be properly
calculated®. Also, it might be helpful to perform a denoising step on the dataset. There

are various tools available, e.g., DenoisEM® or Noise2Void®. Before starting to segment,
determine if you need to work on the full volume or if it is possible to cut certain regions of
interest (ROIs), i.e., each ROl containing a cell (Fig. 3). Furthermore, it may not be necessary
to use the full resolution of the original dataset to segment organelles such as mitochondria
or nuclei. Binning by a factor of 2 or 4 might make sense as suggested in refs. 87,88 and our
own work". This will save a substantial amount of hard drive and memory space. We only
used the full resolution for segmentation of microtubules. You should select and cut ROIs
before binning.

Cutting ROIs containing complete cells

® TIMING 10-30 min

1. Install Fiji by navigating to https://imagej.net/software/fiji/downloads and choosing the
download file according to your operating system.

2. Openthefullresolutionimage stack in Fiji.
4 TROUBLESHOOTING

3. Definethe ROlinxywiththe ‘Rectangle’ tool followed by > Image > Crop.

Afterwards, go through the resulting stack in zand define the start and end of the cell.

5. Cutthecellinzby>Image > Stacks > Tools > Slice Keeper and define ‘First Slice’ and
‘Last Slice’.

6. Makesuretouse‘Increment’1and press OK.

7. Savetheresulting stack as TIFF file.

=

Nature Protocols | Volume 19 | May 2024 | 1436-1466

1447


http://www.nature.com/NatProtocol
https://imagej.net/software/fiji/downloads
https://github.com/CSBDeep/CSBDeep
https://github.com/stardist/stardist/
https://github.com/betaseg/cellsketch
https://vtk.org/
https://www.blender.org/

Protocol

i 5 3 '\\( L.
Fig. 3 | Preparation of raw data for segmentation. a, Full FIB-SEM volume of pancreaticislets containing several cells in
xy,xzand yzviews. Scale bars,2 pm. b, The cell in the marked region of ais cut out in Fiji. Scale bar, 2 pm. ¢, Magnified view
of boxed region of b at the original resolution (4 nm voxels) and after binning (16 nm voxels). Scale bars, 1 um. d, Further
magnifications to demonstrate the differences in resolution. Microtubules (arrow) and ribosomes (asterisk) are barely
visible at 16 nm voxels. Scale bars, 100 nm.

Binning of subvolumes

O TIMING 5 min

8. Openthesubvolume inFiji

9. GotorImagerTransform>Binand define X, Yand Z‘Shrink Factor’. You also need
to choose the ‘Binning Method’ (we recommend Average). Press OK and save the
result as a TIFF file. Alternatively, you can use ‘binvol’ as part of IMOD for binning
(see Supplementary Information).

Preparation for Knossos

@ TIMING 10-30 min

A CRITICAL For skeleton tracing in Knossos, you will need to convert your full resolution vEM

dataset with Knossos cuber.

10. Install the program by following the installation instructions on https://github.com/
knossos-project/knossos_cuber.

11. Navigate to the folder containing Knossos cuber.

12. Openthe ‘scripts’ folder and run the file ‘knossos_cuber_gui.exe’.

13. This opens the GUlwhere you can define the ‘source directory’, the ‘target directory’ and
‘source format’.
4 TROUBLESHOOTING

14. After runningthe program, you can open the result in Knossos.

Preparation for ilastik

® TIMING 10 min

A CRITICAL llastik can openvarious file formats. However, for optimal performance,
you should convert your original file to HDF5. You can do this with the ilastik plugin
in Fiji.

15. Openyour vEM stack in Fiji.

16. GotorPlugins > llastik > Export to HDFS5.

17. Definethe ‘Export Path’and press OK.
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Procedure 2: segmentation

A CRITICAL Werecommend getting acquainted with user-friendly tools such as MIB and ilastik
when starting the segmentation tasks.

Local thresholding and manual segmentation with MIB
® TIMING 45-120 min
A CRITICAL Example data for this workflow can be downloaded from

https://zenodo.org/record/8114392/files/high_c1_source.tif.

1. Install MIB. You will find installation instructions at http://mib.helsinki.fi/downloads.
html. Install the standalone version for your operating system if you do not have a MATLAB
license.

2. OpenMIB.

3. Openyourraw dataset by clicking the ...’ button and navigate to the folder where thefile is
savedin. Press OK and click on the file in the left sidebar (Fig. 4a).

4. Navigate toyour organelle of interest (e.g., centrioles).

5.  Withthe ‘Brush’tool, drawaline close to (for local threshold) or precisely on the organelle.

6. Fillthe annotation by pressing the F key.

7. Annotate every fifth or tenth slice depending on the voxel size of the dataset. Press the I key
forinterpolating between annotated slices.

8. Afterfinishing manual annotation, go to>Selection....>Mask>3D > Current stack(3D) > Add.

9. Nowtheoutline of your annotation will appear in magenta.

10. Switchfrom the ‘Brush’toolto ‘BW Thresholding’. Make sure to check the box ‘Masked area’
to only perform thresholding within the mask and check the ‘3D’ box.
A CRITICALSTEP Change the high and low thresholds until you see areasonable labeling
of your target organellein green.

11. Convertyour labeling into amask by going toSelection....>Mask > 3D > Current stack(3D)
Replace. Export the mask as an AM or TIFF file by clicking > Mask > Save mask as.

12. Import the file into Fiji.

13. Itmight happen that you do not see the annotated area after import into Fiji. In this case,
go to> Process > Binary > Convert to Mask. Select ‘Huang’ for binarization and click OK.
A CRITICALSTEP For plasma membrane segmentation and for the nucleus (especially if
you want to perform spatial analysis later), you should do a precise annotation without local
thresholding. In these cases, export the mask as in Step 11 after labeling.
4 TROUBLESHOOTING

Fig. 4 |Local thresholding with MIB. a, Overview of the MIB window with d, Local thresholding (green) within the masked area. e, Conversion of the area to

raw data. b, xy view of the data with rough annotation surrounding the amask that canbe exported.

centrioles. ¢, Area of b after converting the annotation into a mask (magenta).
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Random forests withilastik

O TIMING 24-48h

14. Installilastik from https://www.ilastik.org/download.htmlaccordingto your operating
system.

15. Openilastik and create a new project by clicking on ‘Autocontext (2-stage)”. Define afile
name for the project and saveit.

16. Loadtheraw datain‘l. Input Data’ by clicking >+Add New > Add separate Image(s) and
choose the HDF5 file you want to open. llastik will then display the file in xy, yzand xz view.

17. Asthenextstep, select 2. Feature Selection’ to select pixel features. Make sure to have 3D
selected especially for isotropic data. For datasets with a huge difference between x, y and
zvalues, it can make sense to select 2D features. More features will increase the likelihood
for better results, but also require more computational resources. Press OK after selecting
the features. For more information on feature selection, we recommend reading the ilastik
documentation at https://www.ilastik.org/documentation/pixelclassification/pixelclassific
ation#selecting-good-features.

18. Performafirst round of training (Fig. 5a). Click on ‘3. Training’ and define labels for your
organelles. Add new labels by clicking ‘+ Add Label’, change colors of the labels by right click
onthe color and change label names by left double clicking.

19. After defininglabels (in our case, vesicles, mitochondria, chromatin and background)
performsparse labeling of the structures with the ‘Brush Cursor’ tool for all labels.

A CRITICALSTEP Inthisfirst round, you should label more than two different organelles,
ideally as many as you can discriminate.

20. Press‘Live Update’ to see the probability map for each label (Fig. 5b). In this first step,
this does not have to be perfect. However, you can improve the results by providing more
annotations.
€ TROUBLESHOOTING

i BEE 2/osms

i et 6 b 45340 ]

Fig. 5| Autocontext segmentation inilastik. a, Overview of the ilastik window ¢, xy view for the second round of annotation with labels for background

with raw data and sparse annotations for four distinct structures (vesicles, (yellow) and mitochondria (blue). d, xy view after the second round of training
mitochondria, cytosol, chromatin). b, xy view of the data after the first round of with probabilities for background (yellow) and mitochondria (blue). e, Object

training with the different probability in the color code according to the labeling. detection of mitochondria (blue).
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21. Byclickingon‘Suggest Features’, you can run an automated feature selection that can help
to optimize the manual selection you did in the previous step. Make sure to click > Project >
Save Projectin between the steps.

22. Ifyouaresatisfied with the first round of training, you may continue to ‘4. Feature Selection’
toselect features for the second training.

23. Afterfeature selection and clicking OK, proceed to ‘5. Training’. Define labels similar to the
first training step. However, now you only provide annotation for your desired organelle
(in our case, mitochondria) and background, which contains labels for all other organelles
and the cytosol (Fig. 5c).

24. Press ‘Live Update’ and provide more annotations until you are satisfied with the
result (Fig. 5d).

4 TROUBLESHOOTING

25. Ifthe probability map for your target organelle looks reasonable, you can proceed to ‘6.
Prediction Export’. In the ‘Export Settings’, you can decide which file you wish to export.

We will export ‘Probabilities Stage 2’ since we later want to perform object detection.
Click on ‘Choose Export Image Settings..., set the file format (HDF5) and give a file name.

26. Click OK and then click ‘Export’.

4 TROUBLESHOOTING

27. Togenerate binary masks needed for analysis you can either export the ‘Simple
Segmentation Stage 2’ files after pixel classification or start anew project ‘Object
Classification [Inputs: Raw Data, Pixel Prediction Map].

28. Loadraw data and the corresponding probability map.

29. Change thresholds until you are satisfied with the binary output.

30. In ‘3. Object Feature Selection’, you can select the features you want to be computed.

31. In‘4.Object Classification’,you need to once label the organelle and press ‘Live Update’.
You will then see all mitochondria labeled (Fig. 5e) and can proceed to ‘5. Object Information
Export’.

32. Exportthe‘Object Predictions’as HDF5.

33. Youcanimportthe HDF5 files into Fiji with the ilastik plugin by going to > Plugins > llastik >
Import HDF5 and select the file. It might be necessary to perform an additional binarization
step, as described for importing files from MIB in Step 12. Afterwards you can save the file
as TIFF.

4 TROUBLESHOOTING

Deep learning for complex and/or convoluted organelles with CSBDeep

O TIMING 12-24h

A CRITICAL For organelles that are highly convoluted and distributed throughout the whole

cell, such as the Golgi apparatus or the ER, a supervised deep learning-based method is often

the most efficient choice. As a semantic segmentation network, we use a U-Net as a robust and

popular architecture for bioimages. For supervised deep learning, you need to provide precisely
annotated ground truth (see box). We found that it can help to generate rough segmentation
masks with Autocontext inilastik (Steps16-33) that can be cleaned inilastik or Labkit similar to

the data curation step at the end of Procedure 2, Steps 66-78.

A CRITICAL Demo data for this workflow can be found at https://zenodo.org/record/8114392/

files/data_golgi.zip, consisting of nine FIB-SEM subvolumes of size 128 x 128 x 128 pixels and

corresponding dense label masks of annotated Golgi apparatus (splitinto train and validation
images/masks).

34. Togenerate ground truth from scratch with Labkit, open your raw dataset in Fiji.

35. Select square ROIs with the ‘Rectangle’ tool. Click on > Edit > Selection > Specify and type
intheidentical xandy dimensions. We recommend 128 x 128 or 256 x 256 pixels. Press OK.
Press>Image > Crop to crop theimageinxandy.

36. To crop theresulting stackin z, go to>Image > Stacks > Tools > Slice Keeper and define the
number of slices you want to keep (128 or 256). Make sure to set the increment to 1. Press OK
and save the resulting stack.

37. Repeatthistogenerate ~20 subvolumes, ideally of various different raw volumes.
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38.

39.
40.

41.

42.

43.

44.

Open one of the volumes in Fiji and change the z-dimension to time [t] by clicking > Image >
Properties and switch t-and z-values. Click OK and save thefile.

Open thefile in Labkit by clicking > Plugins > Labkit > Open Current Image in Labkit.

Start annotation of your organelle of interest with the ‘Draw’ tool. You can navigate
through the dataset in zwith the left and right arrow keys. After carefully labeling all
structures either with one foreground label or with several distinct labels, save your
labeling as TIFF file.

Asanalternative to Steps 33-39, you can generate ground truth withilastik by preparing a
first preliminary segmentation of the objects with Autocontext (as shownin Procedure 2,
Steps 15-33) and export the resulting binary mask into Fiji (Fig. 6).

From the mask, prepare crops with dimensions of 128 x 128 x 128 pixels and if necessary,
correct the labeling in Labkit (as described before).

Prepare 20 crops of corresponding raw images and labels masks and save them as TIFF files
within two folders data/train/images and data/train/masks.

Use the ground truth label files and corresponding raw files to train a semantic
segmentation model by executing the ‘csbdeep_unet_train’ solution provided via Album
(expert users can may directly use a Jupyter Notebook for training without Album
https://github.com/betaseg/protocol-notebooks/blob/main/unet/run_unet.ipynb.

In this case, one can skip Steps 45-53.)

b

Ground truth c Result

Ilastik training

Crop and
clean
—_

Train and
predict
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Fig. 6| Segmentation of crowded insulin SGs with StarDist. a, Initial model training via tensorboard. Shown are the loss curves for both training and
segmentation of SGs via the autocontext workflow inilastik yields preliminary validation, which should gradually decrease. e, The tensorboard will also show
ground truth masks. b, Final ground truth masks are generated by selecting anexample inputslice (left) and the corresponding intermediate model outputs
small crops and manually curating the labels. ¢, After training a StarDist model, (center, object probability; right, distance maps), which both should get more

it can be used to predict on new, full-sized stacks. d, Monitoring the StarDist and more refined during training.
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45. Install Albumusing the install wizard (instructions here: https://docs.album.solutions/en/
latest/installation-instructions.html), this generates a launcher for Album either on your
desktop orinthelist of available applications.

4 TROUBLESHOOTING

46. Afterlaunching Album, click on > catalogsin the bottom left corner.

47. Click>Add catalog.

48. Enter the following URL: https://github.com/betaseg/solutions and confirm. This is
necessary for installing and running the specific solutions mentioned in the following
steps. When running a solution whichis not installed yet, you will be requested to install
itfirst. You need to confirm aninstallation whenever one of the solutions is launched for
thefirsttime.

49. Prepare the data for running the U-Net training. To do so, split the raw data together
with the generated ground truth into two folders named ‘train’and ‘val’. We recommend
putting atleast 20% of the available datain the ‘val’ folder. Each of these folders should
have two subfolders: ‘images’ and ‘masks’, where the raw data and the annotated
ground truth are stored, respectively (note: the demo data are already preparedin
that way).

50. Inthe Album GUIinstall the ‘CSBDeep U-Net Train’ solution by clicking on>run. In the
following pop-up window click on > install. This might take some time. Then, again
clickonrrun.

4 TROUBLESHOOTING

51. Setthearguments for the solution. The only required argument is the root path of the
prepared data from the previous step. Additional optional parameters are, for instance,
the U-Net spatial pooling factor that should align with the anisotropy of the data (e.g., unet_
pool_size=(2,2,2) forisotropic data or unet_pool_size =(2,4,4) for data with twice as large
axial than lateral pixel size, as is the case here). Other parameters that might be adjusted are
the 3D patchsize (128x128x128 by default) that is sampled during training and the batchsize
(default2). As output of the procedure, you obtain a trained model that can be used in
downstream analysis.

4 TROUBLESHOOTING

52. Clickon>runto train the model and monitor the training and validation loss in tensorboard.
The training loss should gradually decrease, while the validation loss should plateau
after 100-150 epochs. If the validation loss starts increasing heavily for later epochs,
then the model overfits, which needs to be avoided. Note that model training is the most
time-consuming part, that may take up to 8-14 h.

4 TROUBLESHOOTING

53. Inthe Album GU], install the ‘CSBDeep U-Net Predict’ solution. This might take some time.
Then, click on > run. Specify the root directory, input TIFF folder or file and an output
directory, and start the inference by clicking again on > run. The solution will automatically
perform prediction on overlappingtiles to allow large stacks to be predicted with limited
GPU memory. The prediction time of a stack of size 256° should be -1 min.

Shape-aware deep learning for densely packed vesicles with StarDist

® TIMING 12-36 h

A CRITICAL For very abundant and densely packed star-convex (roundish) objects such as
SGs or neuronal vesicles StarDist is a well-suited shape-aware segmentation method. StarDist
directly predicts polyhedral shape approximations for each object and typically yields
well-separated label maps even for very crowded scenarios.

A CRITICAL Demo data for this workflow can be found at https://zenodo.org/record/8114392/
files/data_granules.zip consisting of five FIB-SEM subvolumes of size 128 x 128 x 128 pixels and
corresponding dense label masks of annotated SGs.

A CRITICAL The StarDist training workflow in Steps 54-59 uses an Album solution, whereas for
expertusers, we provide a correspondingJupyter Notebook that demonstrates how to traina
3D StarDist model on this dataand how to use it to predict SG segmentation maps on new stacks
here: https://github.com/betaseg/protocol-notebooks/blob/main/stardist/run_stardist.ipynb.
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54. Prepareafirst preliminary segmentation of the vesicles with Autocontext inilastik (as shown
in Procedure 2, Steps 15-33) and export the resulting binary mask into Fiji (Fig. 6). Out of this
mask, prepare crops with dimensions of 128 x 128 x 128 pixels and, if necessary, correct the
labeling in Labkit (as described in Procedure 2, Steps 66-71).

55. Prepare 20 crops of corresponding raw images and labels masks and save them as TIFF files
within two folders data/train/images and data/train/masks.

56. Ifnotyet done,install Album and the BetaSeg solutions catalog as described in Steps 45-48.

57. Inthe Album GU], install the’ StarDist Train” solution by clicking on > run. In the following
pop-up window, click on > install. This might take some time. Then, again click on > run.
Use the crops you prepared as ground truth to train a StarDist 3D model with the help
of the solution by specifying the root folder and the output folder. Note that we highly
recommend using a workstation with an NVIDIA GPU for training if available. The process
witha GPU will take up to 6-8 h.

4 TROUBLESHOOTING

58. Monitor the model performance during training by observing the training/validation loss
intensorboard. The training loss should continuously decrease until the end of training,
whereas the validation loss should similarly decrease for the first 50-100 epochs and then
eventually plateau. Additionally, tensorboard will display the intermediate probability and
distance predictions, which should converge to reasonable values.

4 TROUBLESHOOTING

59. Usethetrained model to predict on new (full) raw stacks using the ‘StarDist Predict’ Album
solution. Use the Album GUI to install the solution. This might take some time. Then, again
click on>run. Specify the model base directory and model name you would, input TIFF
folder or file, and an output directory and start the inference by clicking again on > run.
Depending on the size of the stack, the prediction step may take 0.2-1h.

Manual skeleton tracing with Knossos

® TIMING 1-2 weeks

60. Install Knossos via https://knossos.app/.

61. OpenKnossos and choose the dataset you want to work with (Fig. 7). Press OK.

62. Make sure that you have selected ‘6. Tracing Advanced’ as work mode. Also open the cheat
sheet by clicking on>Help > Cheatsheet.

63. Navigate through the dataset until you find a microtubule. Move to one of the ends of the
microtubule and start to set nodes by aright mouse click.

64. Aftersetting the second node, Knossos will connect the nodes. After reaching the end of
the microtubule, press the C key to make a new tree (microtubule) and continue setting the
nodes for the next microtubule.

65. Your annotationis automatically saved as an XML file, which s later used by Album for the
spatial analysis.

Curation of segmentation results

O TIMING 4-12h

A CRITICAL Nosegmentation result will be perfect, and we generally advise to proof-read

each segmentation mask, ideally by an expert different from the original annotator. For mask

curation, we recommend using either the Labkit plugin in Fiji or ilastik (but your preferred
image analysis software might suffice).

66. For mask curation in Labkit. Open Fiji and load your dataset.

67. For making annotationsin Labkit, itis recommended to change the z-dimension of your
dataset to time [t]. You can do this by clicking on > Image > Properties and set Slices (z) to
land exchange the Frames (t) value with the number of z-slices. Press OK. Do the same also
for the segmentation mask.

68. Toload the raw datain Labkit, go to > Plugins > Labkit > Open Current Image With Labkit.

69. After the Labkit window has opened and you see the raw data you canload the
corresponding segmentation mask by clicking > Labeling > Open Labeling. Choose the file
and click OK.
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Fig.7|Skeleton tracing with Knossos. a, Overview of the Knossos window with
raw data. The inset highlights the portion of the data thatis currently loaded
into memory. b, Knossos window including final skeleton trace of the cell. Left:

the annotation window with single traces in different colors. Below: the nodes

oftheactive trace. The insets highlight one trace with a node and the annotation
time. ¢, Skeleton trace after conversion to binary mask in Fiji with a single slice
through the stack on the left and 3D visualization in the 3D viewer on the right.

70.

71.

72.

73.
74.

75.

76.

77.

78.

You can now navigate through the data with the left/right arrow keys and make
corrections where needed. You can change the brush size and use the ‘Draw’ and

‘Erase’ tool.

Save your changes by clicking on > Labeling > Save Labeling. Make sure to save the

file as TIFF.

For mask curationinilastik. Openilastik and create a new pixel classification project

as shown before.

Open the raw data and proceed until Step ‘3. Training’.

GotorAdvanced > Labels > Import Labels... and choose the corresponding segmentation
file. Press OK.

You can now alter the labeling file with the ‘Brush Cursor’ and ‘Eraser Cursor’ tools.

You should also give afew annotations for the background.

Click on‘Live Update’ and run the prediction.

You canthen export only the corrected label file in ‘4. Prediction Export’ by choosing Labels
assource.

After clicking export, you will save your desired segmentation file and the few labels for the
background.

Procedure 3: volume and spatial analysis

A CRITICAL To performthe analysis of spatial interactions between organelles we use the
Album solution CellSketch, which simplifies the installation and execution of steps spanning
across multiple tools and programming languages. The most recent documentation of this
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a Masks b Label maps c Skeleton trace (XML)

G64-2-1_High_Glucose_Cell_1 Al MTs_.. — o X

<editPosition x="2416" y="814" 2="2801"/>
«skeletonVPState E0="1" E1="0" E2="0" E3="0" E4="0" E5="0"|
<vpSettingsZoom XYPlane="0.888889" XZPlane="0.888889" YZ
</parameters>
<thing id="1" color.r="-1" color.g="-1" color.b="-1" color.a="1">
<nodes>
<node id="1" radius="1.5" x="1967" y="22'
<node id="2" radius="1.5" x="1934" y="2256" 2="2551" invp="
<node id="3" radius="1.5" x="1905" y="2246" 2="2564" invp="
<node id="4" radius="1.5" x="1879" y="2247" 2="2579" invVp="
<node id="5" radius="1.5" x="1843" y="2251" 2="2579" inVp="
=node id="6" radius="1.5" x="1813" y="2255" 2="2584" inVp="
<inodes>
<edges>
<edge source="1"ta

<edge source="5"target="6"/>
<jedges>
<jthing> >
<« [ »

Fig. 8| Types of data to be imported into the analysis project. a, 8 bit TIFF binary masks. b, 16 bit label maps. ¢, Skeleton traces XML files.

workflow can be found on https://github.com/betaseg/cellsketch, including the detailed
command line calls for expert users. The following parts of the protocol show the full analysis
workflow performed via the GUI of Album.

A CRITICAL Demo data for this workflow can be found at https://zenodo.org/record/8114392/
files/high_cl.zip, which consists of the raw images and corresponding segmentation masks

(as obtained by Procedure 2) for amouse pancreatic cell. This dataset has anisotropic pixel size
0f 0.016 pm.

Creating anew CellSketch project

@ TIMING 20 minto1h

1. Tobeabletofollow the full analysis and segmentation protocol, make sure you have the
following datasets available from Procedure 2 (Fig. 8):

< Masks (e.g., TIFF, pixel value zero for background, pixel value 1 or 255 for foreground).
According to Procedure 2, we expect the membrane mask to be filled. Furthermore,
the pixel size must be isotropic, e.g., 0.016 um for the demo data.

« Label maps (e.g., TIFF, each object has the unique pixel value, O for background) of the
vesicles. As before, the pixel size has to be isotropic.

« Thelabeled microtubules are exported from Knossos as XML. As the Knossos
analysis might have used raw images of higher resolution, ensure that the scale factors
of the XML correspond to the lower pixel size of the masks. For example, for the demo
data, the original microtubule segmentation was done on images with a pixel size of
4 nm x 4 nm x 3.4 nm, such that the scale factors need to be [X=0.25, Y=0.25, Z=0.2125]
to resultin the desired target isotropic pixel size of 0.016 pm.

2. Makesureyouinstalled Album and added the BetaSeg catalog as described in Procedure 2,
Steps 45-48. To visualize all segmentations and analysis values of individual organelle and
microtubule instances in the same view, the data are transformed into a CellSketch project.
CellSketchis a collection of solutions for displaying and analysing single cell components.

3. Afterlaunching Album use the search bar or scroll through your list of solutions to find and
runthe ‘CellSketch: Create new project’ solution. You then need to provide the following
parameters:

- parent: choose a folder where the project is going to be created

- name: this name will represent the project, for the demo data you can call it high_cl

- input: one dataset needs to be provided as the source image, for example, your raw
dataset from the data acquisition. It will only be used for visualization purposes as the
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10.

11.

12.

background image. If none exists, one can simply choose one of the available masks.
Any image file format that ImageJ/Fiji can open is expected to work
- pixel_to_um:the conversion factor from pixel units to um units

Since spatial analysis and visualization are performed, the imported datasets need to be
scaled to beisotropic. Use the scale_z parameter to provide a scaling factor for the z axis
if needed.
Anew folderinthe specified parent folder with the ending .n5 will be created. Do not
renameit.
Next, the project will be opened in the CellSketch viewer, displaying the raw dataset. The
view supports arbitrary rotations in 3D. Hover over the right part of the display—an arrow on
theright border will appear. Click on it to show the sidebar of the viewer.
4 TROUBLESHOOTING
Onthe top of theright sidebar, there is abutton called > Add dataset. This will add several
binary masks/label that represent different components of the organelle segmentations.
Adataset has the following properties that you should set appropriately. Name: the name
of'the cell component. Will be used for displaying the component, in table columns and in
filenamesi.e., when exporting meshes. Scale factor X/Y/Zfor dataset: in case the dataset
needs to be scaled to match the (isotropic) dimensions of the source datasets, these scaling
parameters can be used. Color: the dataset will be displayed using this color—it can be later
adjusted in the viewer by clicking the colored rectangle on the right side of the dataset name
inthelist of componentsin the right-side panel. Steps 7-10 below describe each of those
components separately.
Add mask: mask datasets have the value 0 as background and 1 or 255 as foreground. They
mark acomponent of the cell, such as the nucleus, without distinguishing between multiple
entities of the same component.
Add labels: labels can be imported as label masks. Multiple entities of the same component
type canbe encoded by giving each object a unique pixel value whereas O is used for
marking the background. A label mask does not support overlapping labels.
Addboundary: the boundary of the cell is a mask but plays a special role when analyzing the
data. It describes the space which is available for components within the cell. Therefore, the
boundary needs to be afilled mask, not just the membrane itself. CellSketch will automatically
compute the outside border of this mask, add it as a cell component and call it ‘membrane’.
Add filaments from Knossos (optional): in case you used Knossos to annotate filaments,
they can be imported using this option. The following options can be set: analyze
connection to filaments ends: check this box if your project contains filaments and if you
want the connection of their ends to the label map or mask to be analyzed. Threshold to
count filament ends as connected in pm: when calculating the distance between a mask or
label with filaments, this threshold in micrometers is used to mark filaments as connected
to this mask/label.
Note that since regularly exported Knossos files ignores the first z-slices of the dataset that
do not contain annotations, this offset is internally added back depending on the number
of z-slices of the source dataset of the project.
A CRITICALSTEP Adjust the microtubules scale values according to the correct voxel
dimensions and binning factor of the raw data.
To delete animported dataset, click on the three dots next to the bold name of the
component in the side panel on the right and click > Delete.
Todisplay the project at adifferent time, use the search bar or scroll to the solution called
‘CellSketch: Display data in BigDataViewer’ in the Album interface and runiit. Provide the
newly created .n5 directory from the previous step as the project input parameter.

Spatial analysis

O TIMING 30minto2h

A CRITICAL Spatial analysis canbe performed by directly clicking the ‘Analyze’ buttoninthe
right-side panel of the viewer; however, we highly advise running the analysis from a separate
solution without the viewer being opened. The analysis can be very memory consuming.
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13. Runspatial analysis for your CellSketch project via the GUI by using the search bar or
scrollingto the solution called ‘CellSketch: Run spatial analysis’. Run the solution with the
following parameters:

- project: your CellSketch project, the directory ending with .n5.
 connected_threshold_in_um: when analyzing how close two organelles need to be to be
counted as connected, this is the threshold, provided in micrometers.
4 TROUBLESHOOTING

14. Allresults of the analysis are stored into MY_PROJECT.n5/analysis. It will perform the

following steps:
« Distance maps for all imported components are computed. In a distance map, all pixel
values represent the shortest distance of this pixel to a label or mask foreground
« The mean, standard deviation (stdev) and median size of the labels of all label maps are
computed and stored in PROJECT_NAME_LABELMAP_NAME.csv
« Thedistance and connectivity of all labels of all label maps to all masks and other label
maps are computed and stored in PROJECT_NAME_LABELMAP_NAME _individual.
csvindividually for each label. The number of connected versus the number of not
connected labels are stored in PROJECT_NAME_LABELMAP_NAME.csv. This step
includes the label maps of filaments - all filament pixels are considered, not just the
filament ends
- Iffilaments are present, the mean, standard deviation and median length and
tortuosity of the filaments are stored in PROJECT_NAME_FILAMENTS_NAME.csv
- Iffilaments are present, based on the parameters in the previous step, the distance
between their ends and other labels/masks is computed and stored in
PROJECT NAME_FILAMENTS_NAME _individual.csvindividually for each filament, and
the number of connected versus not connected filaments are stored in PROJECT_NAME_
FILAMENTS_NAME.csv

Visualizing spatial analysis in the CellSketch viewer

® TIMING 10 min

A CRITICAL Demo datafor the plotting and visualization components of this protocol can be

found at https://zenodo.org/record/8114392/files/mycell.n5.zip. The CellSketch project folder

(high_cl.n5) already includes all analysis results (as obtained from Steps 13-14).

15. Launchthe CellSketch viewer solution (Album > CellSketch: Display data in BigDataViewer)
todisplay the spatial analysis results.

16. Hover over theright part of the display—an arrow on the right border will appear—and click
onittoshow thesidebar of the viewer.

17. Inthedisplayed list of all cell components, click on the eye symbols of the specific analysis
component that should be visualized (Fig. 9). For example, displaying a distance map
(i.e., the Golgi distance map) will show pixels further away from the respective target
(inthis case, the Golgi) in an opaquer white color. Displaying the attribute of a specific
label, for example, the distance of SGs to the membrane, will color each label in respect
to the value of the attribute for this specific object. All attributes of a specific label are also
displayed as textin the top right corner of the viewer after clicking oniit.

Exporting connectivity masks

® TIMING 10 min

A CRITICAL The CellSketch viewer can be used as a tool to generate TIFF masks of labels

connected to specific masks. This can be useful for further analysis or visualization purposes.

18. Launchthe CellSketch viewer solution (Album > CellSketch: Display datain BigDataViewer)
todisplay the spatial analysis results.

19. Hover over theright part of the display—an arrow on the right border will appear—click oniit
to show the sidebar of the viewer.

20. Inthe displayed list of all cell components, scroll to the entry of alabel map dataset, for
example, ‘microtubules’. There should be connectivity entries listed below, for example,
‘connected to centrioles’in case you added a centrioles mask.
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Fig. 9| CellSketch viewer. a, The CellSketch viewer displaying the datasets analysis results of a CellSketch project, in this case the distance ofvesncles tothe
imported into a new CellSketch project. b, The CellSketch viewer displaying the cellmembrane and the distance map of the membrane.

21. Clickonthethree dots ontheright side of a connectivity entry and click > Export mask.
Click > Exportinverted mask to export the labels which are not connected.

22. The masks are exported as TIFF. The progress bar in the ImageJ main panel, which opens
alongside the CellSketch viewer, displays the export status. Once it is finished, the masks
canbe foundin MY_PROJECT.n5/export.

Generating plots
O TIMING 15 minto1h
A CRITICAL We provide aJupyter Notebook (https://github.com/betaseg/protocol-notebooks/
blob/main/plots/run_plots.ipynb) showing how plots can be generated based on the analysis
from the previous step. When running the notebook on the provided demo data, it should run
without adjustments. To avoid installation of the Python dependencies, we distribute this
workflow as an Album solution that makes it possible to run the notebook automatically in the
correct environment, as follows:
23. Afterlaunching Album, use the search bar or scroll to the solution called ‘CellSketch:
Plot analysis results’. Run the solution with the following parameters:
« project: your CellSketch project, the directory ending with .n5
« output: the directory where plots generated in the notebook will be saved to (Fig. 10).
This will also contain a copy of the notebook which can be further adjusted to generate
more plots or to adjust the plots to a specific project
24. When running this command for the first time, the provided exemplary notebook will be
executed and a copy of the notebook, including the result of the execution, will be stored

a b c
60% 100%  30.0%

I Not assoc. I Not assoc.

50%
t 80% Assoc. 4 4 [0 Assoc.

40% - 20.0%
t 60%

30% -
L 40%
20% 2 10.0%

10% r 20%

Distance to Golgi (um)

0% T T T T 0% 0% f u
0] 1 2 3 4 5 0o 1 2 3 4 5

Distance to Golgi (um) Distance to Golgi (um)
Fig.10 | Plots generated from the spatial analysis results. a, Distribution of of microtubule-associated (assoc.) and not-associated insulin SGs to the Golgi
the distances of insulin SGs to the Golgi apparatus. The black solid line indicates apparatus. ¢, Violin plot showing the distance of microtubule-associated and
arandom distribution. Red dotted and black dotted lines represent actual and not-associated insulin SGs to the Golgi apparatus.
random cumulative distributions, respectively. b, Distribution of the distances
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inthe provided output directory. Afterwards, and when running the solution with an

output directory that already contains the notebook, the solution will initiate a newJupyter
Notebook session and open the browser with the output Jupyter interface where one can
click on plots.ipynb to adjust the notebook.

A CRITICALSTEP The notebook generates plots based on the datasets added to the projects
programmatically, butit alsoincludes a custom example accessing the analysis results of
specific organelles explicitly. If the project has different cell component names than the
exemplary dataset, this example will fail and the notebook will include messages that an
exception occurred. Adjust the code in the notebook to generate plots based on the naming
ofthe cell componentsinyour project or delete the last cell.

Procedure 4: visualization of vEM segmentation data

A CRITICAL Wefocusonhow to produce 3D renderings with Blender. Instructions for
generating 2D overlays in 3D script and for 3D rendering in ORS Dragonfly can be found in the
supplementary workflows. The steps for generating renderings in Blender are provided as
Album solutions and integrated into the CellSketch workflow.

Visualization with VTK and Blender

O TIMING 2-24h

A CRITICAL We provide Album solutions to automatically generate meshes from

segmentations and labels masks, import the meshes into Blender, apply colored materials

to each component and generate a scene that can be rendered in high quality. Before the full

rendering in Blender, results can be quickly evaluated in the VTK.

A CRITICAL Demo datafor this workflow is available at https://zenodo.org/record/8114392/

files/mycell.n5.zip, which contains the CellSketch project folder high_c1.n5 with all analysis

results obtained earlier.

A CRITICAL Make sure that you haveinstalled Album and added the BetaSeg catalog as

describedin Procedure 2, Steps 45-48.

1. Afterlaunching Album, use the search bar or scroll to the solution called ‘CellSketch:
Export masks and labelmaps as meshes’. Run the solution with the following parameter:

« project: your CellSketch project, the directory ending with .n5
A CRITICAL STEP The optional parameters ‘include’ and ‘exclude’ provide ways of
choosing a subset of datasets. Only components containing the include string in their
name will be exported, dataset names containing the exclude string will be ignored.
Multiple inclusion strings can be provided by separating them by a comma, for
example, mito,nucleus.

2. Themeshesgeneratedinthe previous step were saved to MY_PROJECT.n5/export/meshes
or therespective folder in your CellSketch project directory. Launch the solution called
‘CellSketch: Display exported meshes’ to visually inspect the exported meshes in VTK with
your project as the input parameter (Fig. 11).

3. EitheropenBlender andimportall generated STL files manually via> File > Import > Stl or
use the solution called ‘CellSketch: Generate Blender scene from mesh files’ to importall
meshes jointly from a folder. The script will also adjust the viewport of the camera to ensure
allmeshes are visible and assign a glass material in the color as specified in the CellSketch
project to each cell component. Run the solution with the following parameters:

- project: your CellSketch project, the directory ending with .n5

« output_blend: the path to where the Blender project file will be stored, useful for further
adjustments of the scene
4 TROUBLESHOOTING

4. Youcanmanually assign or edit materials to each object by clicking on the > Shading
workspace in the top center area, selecting the object on the right, and adjusting or adding
amaterialin the lower part of the user interface.
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Cellsketch: Display exported meshes

Displays all exported meshes from a CellSketch project using
vtkplotlib. Colors can be adjusted in the CellSketch BigDataViewer app.

Starting cellsketch-mesh-view

Loading dataset from mycell centrioles..

Loading mesh from /home/deschmi/Development/album/col
Loading dataset from mycell golgi..

Loading mesh from /home/deschmi/Development/album/col
Loading dataset from mycell mitochondria.. |
Loading mesh from /home/deschmi/Development/album/col
Loading dataset from mycell nucleus.. \
Loading mesh from /home/deschmi/Development/album/col
Loading dataset from mycell granules.. |
Loading mesh from /home/deschmi/Development/album/col|
Loading dataset from mycell microtubules.. \
Loading mesh from /home/deschmi/Development/album/col
Loading dataset from mycell membrane..

‘ >

Fig.11|Exported meshes displayed in VTK. Cell components from a CellSketch project are automatically exported as meshes and displayed in VTK with a single
solution call.

5. Youcannow openthe Blender project stored at output_blend with Blender—either you
already have Blender installed, then just openit there, or use the Album solution by launching
Album, using the search bar, or scrolling to the solution called Launch Blender 3.3.1.

6. Click>Render>Renderimage to render the cell (Fig. 12c). Adjustments to the rendering
canbe done after selecting the > Rendering workspace in the top centre area. Select Cycles
intheright area as Render Engine for enhanced material rendering. GPU devices can be
configured by clicking > Preferences > System - Cycles Render Devices.

Check colors for color-blind friendliness

@ TIMING 10 min

A CRITICAL Inallthe procedures above, one can define a color palette for the organelles,
which should be used throughout the project (Fig. 12a). Itis important that this color palette
isadjusted to be color-blind friendly. You can check the palette file or one of the 3D renderings
for color-blind friendliness by

7. InFiji: go tolmage > Color > Simulate Color Blindness.

8. Definethe type of color blindness you want to check and press OK.

9. Youwill see how your colors will appear to people with the specific kind of color blindness.
10. Change your palette if the colors cannot be easily discriminated against.

a b Assoc. + Mitochondria Nucleus c

FF8C73 Assoc. vesicles not assoc. vesicles

BFBFBF Not assoc. vesicles

OOA1FF Mitochondria

FFCC66 Nucleus

C63929 Microtubules M|toch9ndrla ) Qolgl All organelles

Centrioles  Golgi microtubules

531C87 Centrioles

2DB98A Golgi

656565 Plasma membrane
Fig.12|3D visualization of vEM data. a, Color palette with HTML color same cell asin b with Blender. Panel b adapted fromrref. 11, under a Creative
codes and corresponding organelles. b, 3D renderings of organelles shown Commons license CC BY 4.0.

separately and as acomplete cell in ORS Dragonfly. ¢, 3D rendering of the
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Troubleshooting

Troubleshooting advice canbe found in Table 6.

Table 6 | Troubleshooting table

Step Problem Possible reasons Solution

Procedure1

2 Full vEM volume cannot be Raw data are too large for computer Open file as virtual stack in Fiji or IMOD, or bin file before preparing
opened memory crops

13 Conversion for Knossos Image stack is not present as single Convert stack into single TIFFs before conversion
does not work TIFF files

Procedure 2

13,33 Imported segmentation mask You forgot to perform Object Detection Perform the Object Detection step in ilastik by clicking once on the
is black in Fiji inilastik or you did not yet convert the file  desired organelle and press ‘Live Update’. After importing the mask

into a binary mask in Fiji into Fiji, go to Process > Binary > Convert to Mask and choose a method
for binarization. Now your labels should be visible

20,24 Ilastik probability map does not Not enough labels for training Increase the number of labels or add more classes in the first
look reasonable Autocontext classification step

26 Export of ilastik probability map Probability maps are very large files since  Let the export run overnight
takes a very long time they contain foreground and background

masks in 32 bit

45 The installation of Album via The wizard is running the Micromamba You can ignore this request when using Album from the GUI. Also, refer
the Install Wizard asks for init call to add the Album Micromamba to the Album troubleshooting page (https://docs.album.solutions/en/
administrator permissions installation to the environment variables latest/fag.html)

(Windows) of the system in order to enable Album

usage from the command line
The installation of Album via the The wizard uses pip to download Adjust your network settings to allow access to the internet. Also, refer
Install Wizard fails due to network  resources when installing Album to the Album troubleshooting page (https://docs.album.solutions/en/
issues latest/fag.html)

50,53, Installation of Aloum solution fails — Refer to the Album troubleshooting page (https://docs.album.solutions/

57,59 en/latest/fag.html)

Solution installation fails due to Some solutions may require git to Install git for your system (https://github.com/git-guides/install-git)
missing git command download and install packages

51,57 GPU out of memory (before The solution might expect a larger default  Reduce the GPU limit by setting the ‘limit_gpu_memory’ value to the
training) GPU memory than available correct memory of your GPU (in MB)

52,58 Validation loss is heavily Indicates that training data are not Check your ground truth and correct it. Prepare more crops from
increasing after a certain number  sufficient or were wrongly annotated diverse regions of the cell (also with negative examples) and label them
of epochs (overfitting) precisely. Add more data augmentation
GPU out of memory (during The size of cropped training patches Decrease the patchsize (e.g., to 96 x 96 x 96) or batchsize (e.g., to 2)
training) and/or batchsize is too high parameter of the Album solution

Procedure 3

5 Datasets are invisible/completely — Datasets are displayed in the range of Navigate into the PROJECT.n5 directory. Continue to navigate into
white their minimal and maximal value. This the directory of the incorrectly displayed dataset (i.e., PROJECT.N5/

sometimes is read incorrectly from the PROJECT source.n5). Open the attributes.json file. It should look
metadata similar to this: {“min”:0.0,"color”:-8224126,"max":1.0,"dataType":“uint8”,"
n5":“2.5.1","compression”:{“type”:“raw"},“blockSize":[64,64,64],"
dimensions”:[828,718,2831}
Adjust or add the min and max values in there to the correct values and
relaunch the CellSketch Viewer

13 Spatial analysis crashes or The memory of the system is not sufficient Distance maps are the most memory-expensive to compute. In case
unexpectedly quits before to perform the analysis the analysis process crashes because of memory issues, repeat the
finishing analysis process and select the ‘skip existing distance maps’ checkbox.

It will not recompute already computed distance maps. This has to
be unchecked whenever an existing dataset is deleted or changed.
Otherwise, use a system with more RAM

Procedure 4

3 Obijects are not visible in Blender ~ Your objects are not aligned with Select one of your objects (i.e., membrane). Go to > View > Align View

the camera

> Align Active Camera to Selected
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Timing

Theinformation ontimingin Procedurelis referring to one cell out of alarge vEM stack with
voxel dimensions of ~7,500 x 7,500 x 5,000 pixels. For Procedure 2 the timing is estimated for
segmentation of one cell (-1/5 of the original stack) binned with factor 4 (except for microtubule
segmentation, which was performed at the original resolution). The timing of processes 3 and 4
also refer to one cell of the original volume.

Procedure1: preparation of raw data
Steps1-7:10-30 min

Steps 8-9:5min

Steps10-14:10-30 min

Steps15-17:10 min

Procedure 2: segmentation
Steps1-13:45-120 min
Steps14-33:24-48h
Steps34-53:12-24h

Steps 54-59:12-36 h

Steps 60-65:1-2 weeks

Steps 66-78:4-12h

Procedure 3: spatial analysis
Steps1-12:20 mintolh
Steps13-14:30minto2h
Steps15-17:10 min
Steps18-22:10 min
Steps23-24:15mintolh

Procedure 4: visualization
Steps1-6:2-24h
Steps 7-10:10 min

Anticipated results

This protocol provides modular steps for achieving the precise 3D segmentation of various
organelle classes out of vEM datasets followed by spatial analysis and 3D visualization.

At the beginning of the protocol, we give advice on the preparation of the raw vEM data
including binning and file conversion. After these first steps, the data will have the optimal size
and file format(s) for the following segmentation tasks.

The user should be able to decide which segmentation strategy best matches their organelle
of interest and will then able to perform these tasks in a time-efficient manner.

After successful segmentation and curation of the segmentation masks, the user will be able
to perform volume analysis of the organelles as well as investigate spatial interactions between
different organelle classes (Fig. 13a,d-f).

Finally, 3D rendering of the segmentation results can be applied to generate
publication-ready figures and videos (Fig. 13b,c).

The steps for spatial analysis, plotting of the results and 3D rendering with Blender are
implemented in solutions that can be run across platforms by using Album. This makes it
possible to achieve publication-ready plots and renderings within a few hours after finalizing
the segmentation tasks.
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Fig.13 | Results of segmentation, spatial analysis and 3D rendering of cumulative data. e, Plot depicting the distance of MT ends to the plasma
avEM dataset. a, A screenshot of raw data and organelle segmentation masks membrane of the cell. f, Distance of SGs to the plasma membrane. The black
loaded in CellSketch. b, 3D rendering in VTK of a complete cell after meshing solid lineindicates random distribution. The red dotted line indicates the
with CellSketch. ¢, 3D rendering of the same cell in Blender. d, Plot depicting cumulative data; black dotted line the cumulative random distribution.

the microtubule (MT) lengths of the cell. The red dotted line indicates the

The user can expect to get fundamental insights into their vEM data with information on the
volume fractions, shapes and distribution of organelles within cells. When comparing different
cell culture or disease conditions, the analysis enables addressing structural changes within
cellsin an unprecedented manner. In our project”, we were able to evaluate heterogeneities
between cells regardless of the culture conditions, by calculating volume fractions of organelles.
We could find differences in microtubule lengths between metabolic stimuli—a key hint that
metabolisminfluences ultrastructure. Spatial analysis enabled us to unravel the connectivity
of microtubulesin beta cells. They were largely noncentrosomal and surprisingly also not
Golgi connected. Measuring the 3D association of insulin SGs with microtubules allowed us
to categorize SGsin ‘associated’ and ‘not associated’, and the finding that microtubule-SG
interaction preferably occursinthe cell periphery. Plotting spatial data against random
distributions further allowed us to investigate possible regulated processes in the cell, which
we could observe in the case of the enrichment of insulin SGs and microtubules close to the
plasmamembrane. In addition to the plotted data, 3D renderings helped to experience the
datamoreintuitively and to appreciate better the crowding of the cytoplasm, the different
cell and organelle shapes, as well as the basic organization of the microtubule scaffolds.
Moreover, these procedures have recently been applied to reconstruct beta cell primary cilia
out of vEM images®. In summary, our protocol provides a complete segmentation, analysis
and visualization pipeline to fully embrace the complexity of modern vEM data.

Reporting summary
Furtherinformation on research designis available in the Nature Portfolio Reporting Summary
linked to this article.
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Data availability
Allraw datasets at their original resolution are available at OpenOrganelle (https://
openorganelle.janelia.org/). Demo data of raw data, segmentation masks, deep learning
training data and spatial analysis are available at https://zenodo.org/record/8114392.
Further information on the demo data can be found in the Supplementary Information.

Code availability
The code for Albumis available at https://gitlab.com/album-app/album. The code for the Album
solutionsis available at https://github.com/betaseg/solutions. The code for the CellSketch
viewer is available at https://github.com/betaseg/cellsketch. The Jupyter Notebooks for demo
workflows canbe found at https://github.com/betaseg/protocol-notebooks.
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Statistics

For all statistical analyses, confirm that the following items are present in the figure legend, table legend, main text, or Methods section.

Confirmed

The exact sample size (n) for each experimental group/condition, given as a discrete number and unit of measurement
|X| A statement on whether measurements were taken from distinct samples or whether the same sample was measured repeatedly

D The statistical test(s) used AND whether they are one- or two-sided
Only common tests should be described solely by name; describe more complex techniques in the Methods section.

[ ] A description of all covariates tested

|:| A description of any assumptions or corrections, such as tests of normality and adjustment for multiple comparisons

X XX X OO 5

D A full description of the statistical parameters including central tendency (e.g. means) or other basic estimates (e.g. regression coefficient)
AND variation (e.g. standard deviation) or associated estimates of uncertainty (e.g. confidence intervals)

D For null hypothesis testing, the test statistic (e.g. F, t, r) with confidence intervals, effect sizes, degrees of freedom and P value noted
Give P values as exact values whenever suitable.

X

|:| For Bayesian analysis, information on the choice of priors and Markov chain Monte Carlo settings

|:| For hierarchical and complex designs, identification of the appropriate level for tests and full reporting of outcomes

X X X

|:| Estimates of effect sizes (e.g. Cohen's d, Pearson's r), indicating how they were calculated

Our web collection on statistics for biologists contains articles on many of the points above.

Software and code

Policy information about availability of computer code

Data collection  All raw datasets at their original resolution are available at OpenOrganelle (https://openorganelle. janelia.org/). Demo data of raw data,
segmentation masks, deep learning training data and spatial analysis are available at https://zenodo.org/record/8114392. Further information
on the demo data can be found in the supplementary information.

Data analysis The code for Album is available at https://gitlab.com/album-app/album. The code for the Album solutions is available at https://github.com/
betaseg/solutions. The code for the CellSketch viewer is available at https://github.com/betaseg/cellsketch. The Jupyter notebooks for demo
workflows can be found at https://github.com/betaseg/protocol-notebooks.

For manuscripts utilizing custom algorithms or software that are central to the research but not yet described in published literature, software must be made available to editors and
reviewers. We strongly encourage code deposition in a community repository (e.g. GitHub). See the Nature Portfolio guidelines for submitting code & software for further information.




Data

Policy information about availability of data
All manuscripts must include a data availability statement. This statement should provide the following information, where applicable:

- Accession codes, unique identifiers, or web links for publicly available datasets
- A description of any restrictions on data availability

- For clinical datasets or third party data, please ensure that the statement adheres to our policy

All raw datasets at their original resolution are available at OpenOrganelle (https://openorganelle. janelia.org/). Demo data of raw data, segmentation masks, deep
learning training data and spatial analysis are available at https://zenodo.org/record/8114392. Further information on the demo data can be found in the
supplementary information.
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Policy information about studies involving human research participants and Sex and Gender in Research.

Reporting on sex and gender n/a

Population characteristics n.a
Recruitment n/a
Ethics oversight n/a

Note that full information on the approval of the study protocol must also be provided in the manuscript.

Field-specific reporting

Please select the one below that is the best fit for your research. If you are not sure, read the appropriate sections before making your selection.

|X| Life sciences |:| Behavioural & social sciences |:| Ecological, evolutionary & environmental sciences

For a reference copy of the document with all sections, see nature.com/documents/nr-reporting-summary-flat.pdf

Life sciences study design

All studies must disclose on these points even when the disclosure is negative.

Sample size This protocol is using publicly available data.
Data exclusions  n/a
Replication n/a
Randomization  n/a

Blinding n/a

Behavioural & social sciences study design

All studies must disclose on these points even when the disclosure is negative.

Study description Briefly describe the study type including whether data are quantitative, qualitative, or mixed-methods (e.g. qualitative cross-sectional,
quantitative experimental, mixed-methods case study).

Research sample State the research sample (e.g. Harvard university undergraduates, villagers in rural India) and provide relevant demographic
information (e.g. age, sex) and indicate whether the sample is representative. Provide a rationale for the study sample chosen. For
studies involving existing datasets, please describe the dataset and source.

Sampling strategy Describe the sampling procedure (e.g. random, snowball, stratified, convenience). Describe the statistical methods that were used to
predetermine sample size OR if no sample-size calculation was performed, describe how sample sizes were chosen and provide a




Data collection

Timing

Data exclusions

Non-participation

Randomization

rationale for why these sample sizes are sufficient. For qualitative data, please indicate whether data saturation was considered, and
what criteria were used to decide that no further sampling was needed.

Provide details about the data collection procedure, including the instruments or devices used to record the data (e.g. pen and paper,
computer, eye tracker, video or audio equipment) whether anyone was present besides the participant(s) and the researcher, and
whether the researcher was blind to experimental condition and/or the study hypothesis during data collection.

Indicate the start and stop dates of data collection. If there is a gap between collection periods, state the dates for each sample
cohort.

If no data were excluded from the analyses, state so OR if data were excluded, provide the exact number of exclusions and the
rationale behind them, indicating whether exclusion criteria were pre-established.

State how many participants dropped out/declined participation and the reason(s) given OR provide response rate OR state that no
participants dropped out/declined participation.

If participants were not allocated into experimental groups, state so OR describe how participants were allocated to groups, and if
allocation was not random, describe how covariates were controlled.

Ecological, evolutionary & environmental sciences study design

All studies must disclose on these points even when the disclosure is negative.

Study description

Research sample

Sampling strategy

Data collection

Timing and spatial scale

Data exclusions

Reproducibility

Randomization

Blinding

Briefly describe the study. For quantitative data include treatment factors and interactions, design structure (e.g. factorial, nested,
hierarchical), nature and number of experimental units and replicates.

Describe the research sample (e.g. a group of tagged Passer domesticus, all Stenocereus thurberi within Organ Pipe Cactus National
Monument), and provide a rationale for the sample choice. When relevant, describe the organism taxa, source, sex, age range and
any manipulations. State what population the sample is meant to represent when applicable. For studies involving existing datasets,
describe the data and its source.

Note the sampling procedure. Describe the statistical methods that were used to predetermine sample size OR if no sample-size
calculation was performed, describe how sample sizes were chosen and provide a rationale for why these sample sizes are sufficient.

Describe the data collection procedure, including who recorded the data and how.
Indicate the start and stop dates of data collection, noting the frequency and periodicity of sampling and providing a rationale for
these choices. If there is a gap between collection periods, state the dates for each sample cohort. Specify the spatial scale from which

the data are taken

If no data were excluded from the analyses, state so OR if data were excluded, describe the exclusions and the rationale behind them,
indicating whether exclusion criteria were pre-established.

Describe the measures taken to verify the reproducibility of experimental findings. For each experiment, note whether any attempts to
repeat the experiment failed OR state that all attempts to repeat the experiment were successful.

Describe how samples/organisms/participants were allocated into groups. If allocation was not random, describe how covariates were
controlled. If this is not relevant to your study, explain why.

Describe the extent of blinding used during data acquisition and analysis. If blinding was not possible, describe why OR explain why
blinding was not relevant to your studly.

Did the study involve field work? |:| Yes |:| No

Field work, collection and transport

Field conditions

Location

Access & import/export

Disturbance

Describe the study conditions for field work, providing relevant parameters (e.g. temperature, rainfall).

State the location of the sampling or experiment, providing relevant parameters (e.g. latitude and longitude, elevation, water depth).
Describe the efforts you have made to access habitats and to collect and import/export your samples in a responsible manner and in
compliance with local, national and international laws, noting any permits that were obtained (give the name of the issuing authority,

the date of issue, and any identifying information).

Describe any disturbance caused by the study and how it was minimized.
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Reporting for specific materials, systems and methods

We require information from authors about some types of materials, experimental systems and methods used in many studies. Here, indicate whether each material,
system or method listed is relevant to your study. If you are not sure if a list item applies to your research, read the appropriate section before selecting a response.

Materials & experimental systems Methods
Involved in the study n/a | Involved in the study
Antibodies |Z |:| ChIP-seq
Eukaryotic cell lines |Z |:| Flow cytometry
Palaeontology and archaeology |Z |:| MRI-based neuroimaging

Animals and other organisms
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Dual use research of concern

Antibodies

Antibodies used Describe all antibodies used in the study, as applicable, provide supplier name, catalog number, clone name, and lot number.

Validation Describe the validation of each primary antibody for the species and application, noting any validation statements on the
manufacturer’s website, relevant citations, antibody profiles in online databases, or data provided in the manuscript.

Eukaryotic cell lines

Policy information about cell lines and Sex and Gender in Research

Cell line source(s) State the source of each cell line used and the sex of all primary cell lines and cells derived from human participants or
vertebrate models.

Authentication Describe the authentication procedures for each cell line used OR declare that none of the cell lines used were authenticated.

Mycoplasma contamination Confirm that all cell lines tested negative for mycoplasma contamination OR describe the results of the testing for
mycoplasma contamination OR declare that the cell lines were not tested for mycoplasma contamination.

Commonly misidentified lines Name any commonly misidentified cell lines used in the study and provide a rationale for their use.
(See ICLAC register)

Palaeontology and Archaeology

Specimen provenance Provide provenance information for specimens and describe permits that were obtained for the work (including the name of the
issuing authority, the date of issue, and any identifying information). Permits should encompass collection and, where applicable,

export.

Specimen deposition Indicate where the specimens have been deposited to permit free access by other researchers.

Dating methods If new dates are provided, describe how they were obtained (e.g. collection, storage, sample pretreatment and measurement), where
they were obtained (i.e. lab name), the calibration program and the protocol for quality assurance OR state that no new dates are
provided.

|:| Tick this box to confirm that the raw and calibrated dates are available in the paper or in Supplementary Information.

Ethics oversight Identify the organization(s) that approved or provided guidance on the study protocol, OR state that no ethical approval or guidance
was required and explain why not.

Note that full information on the approval of the study protocol must also be provided in the manuscript.

Animals and other research organisms

Policy information about studies involving animals; ARRIVE guidelines recommended for reporting animal research, and Sex and Gender in
Research

Laboratory animals For mouse data see Muller et al. "3D FIB-SEM reconstruction of microtubule—organelle interaction in whole primary mouse B cells."
Journal of Cell Biology 220.2 (2021). https://doi.org/10.1083/jcb.202010039




Wild animals n/a
Reporting on sex n/a
Field-collected samples n/a

Ethics oversight n/a

Note that full information on the approval of the study protocol must also be provided in the manuscript.

Clinical data

Policy information about clinical studies

All manuscripts should comply with the ICMJE guidelines for publication of clinical research and a completed CONSORT checklist must be included with all submissions.

Clinical trial registration  Provide the trial registration number from ClinicalTrials.gov or an equivalent agency.

Study protocol Note where the full trial protocol can be accessed OR if not available, explain why.
Data collection Describe the settings and locales of data collection, noting the time periods of recruitment and data collection.
Outcomes Describe how you pre-defined primary and secondary outcome measures and how you assessed these measures.

Dual use research of concern

Policy information about dual use research of concern

Hazards

Could the accidental, deliberate or reckless misuse of agents or technologies generated in the work, or the application of information presented
in the manuscript, pose a threat to:

Yes

[ ] Public health

|:| National security

|:| Crops and/or livestock
|:| Ecosystems

OO0oofds

|:| Any other significant area

Experiments of concern
Does the work involve any of these experiments of concern:
Yes
Demonstrate how to render a vaccine ineffective
Confer resistance to therapeutically useful antibiotics or antiviral agents
Enhance the virulence of a pathogen or render a nonpathogen virulent
Increase transmissibility of a pathogen
Alter the host range of a pathogen
Enable evasion of diagnostic/detection modalities

Enable the weaponization of a biological agent or toxin

OoOodOooods
Ooooooogno

Any other potentially harmful combination of experiments and agents

ChlIP-seq

Data deposition
|:| Confirm that both raw and final processed data have been deposited in a public database such as GEO.

|:| Confirm that you have deposited or provided access to graph files (e.g. BED files) for the called peaks.

Data access links For "Initial submission" or "Revised version" documents, provide reviewer access links. For your "Final submission" document,
May remain private before publication. | provide a link to the deposited data.

Files in database submission Provide a list of all files available in the database submission.
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Genome browser session Provide a link to an anonymized genome browser session for "Initial submission" and "Revised version" documents only, to

(e.g. UCSC) enable peer review. Write "no longer applicable" for "Final submission" documents.
Methodology
Replicates Describe the experimental replicates, specifying number, type and replicate agreement.
Sequencing depth Describe the sequencing depth for each experiment, providing the total number of reads, uniquely mapped reads, length of reads and

whether they were paired- or single-end.

Antibodies Describe the antibodies used for the ChIP-seq experiments; as applicable, provide supplier name, catalog number, clone name, and lot
number.

Peak calling parameters | Specify the command line program and parameters used for read mapping and peak calling, including the ChlP, control and index files
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used.
Data quality Describe the methods used to ensure data quality in full detail, including how many peaks are at FDR 5% and above 5-fold enrichment.
Software Describe the software used to collect and analyze the ChlP-seq data. For custom code that has been deposited into a community

repository, provide accession details.

Flow Cytometry

Plots

Confirm that:
|:| The axis labels state the marker and fluorochrome used (e.g. CD4-FITC).

|:| The axis scales are clearly visible. Include numbers along axes only for bottom left plot of group (a 'group' is an analysis of identical markers).
|:| All plots are contour plots with outliers or pseudocolor plots.

|:| A numerical value for number of cells or percentage (with statistics) is provided.

Methodology

Sample preparation Describe the sample preparation, detailing the biological source of the cells and any tissue processing steps used.

Instrument Identify the instrument used for data collection, specifying make and model number.

Software Describe the software used to collect and analyze the flow cytometry data. For custom code that has been deposited into a
community repository, provide accession details.

Cell population abundance Describe the abundance of the relevant cell populations within post-sort fractions, providing details on the purity of the
samples and how it was determined.

Gating strategy Describe the gating strategy used for all relevant experiments, specifying the preliminary FSC/SSC gates of the starting cell

population, indicating where boundaries between "positive" and "negative" staining cell populations are defined.

|:| Tick this box to confirm that a figure exemplifying the gating strategy is provided in the Supplementary Information.

Magnetic resonance imaging

Experimental design

Design type Indicate task or resting state; event-related or block design.

Design speciﬂcations Specify the number of blocks, trials or experimental units per session and/or subject, and specify the length of each trial
or block (if trials are blocked) and interval between trials.

Behavioral performance measures State number and/or type of variables recorded (e.g. correct button press, response time) and what statistics were used
to establish that the subjects were performing the task as expected (e.g. mean, range, and/or standard deviation across
subjects).




Acquisition

Imaging type(s) Specify: functional, structural, diffusion, perfusion.
Field strength Specify in Tesla
Sequence & imaging parameters Specify the pulse sequence type (gradient echo, spin echo, etc.), imaging type (EPI, spiral, etc.), field of view, matrix size,

slice thickness, orientation and TE/TR/flip angle.

Area of acquisition State whether a whole brain scan was used OR define the area of acquisition, describing how the region was determined.

Diffusion MRI [ ]Used [ ] Notused

Preprocessing

Preprocessing software Provide detail on software version and revision number and on specific parameters (model/functions, brain extraction,
segmentation, smoothing kernel size, etc.).

Normalization If data were normalized/standardized, describe the approach(es): specify linear or non-linear and define image types used for
transformation OR indicate that data were not normalized and explain rationale for lack of normalization.

Normalization template Describe the template used for normalization/transformation, specifying subject space or group standardized space (e.g.
original Talairach, MNI305, ICBM152) OR indicate that the data were not normalized.

Noise and artifact removal Describe your procedure(s) for artifact and structured noise removal, specifying motion parameters, tissue signals and
physiological signals (heart rate, respiration).

Volume censoring Define your software and/or method and criteria for volume censoring, and state the extent of such censoring.

Statistical modeling & inference

Model type and settings Specify type (mass univariate, multivariate, RSA, predictive, etc.) and describe essential details of the model at the first and
second levels (e.g. fixed, random or mixed effects; drift or auto-correlation).

Effect(s) tested Define precise effect in terms of the task or stimulus conditions instead of psychological concepts and indicate whether
ANOVA or factorial designs were used.

Specify type of analysis: [ | Whole brain [ | ROI-based [ | Both

Statistic type for inference Specify voxel-wise or cluster-wise and report all relevant parameters for cluster-wise methods.
(See Eklund et al. 2016)

Correction Describe the type of correction and how it is obtained for multiple comparisons (e.g. FWE, FDR, permutation or Monte Carlo).

Models & analysis

n/a | Involved in the study
|:| |:| Functional and/or effective connectivity

|:| |:| Graph analysis

|:| |:| Multivariate modeling or predictive analysis

Functional and/or effective connectivity Report the measures of dependence used and the model details (e.g. Pearson correlation, partial correlation,
mutual information).

Graph analysis Report the dependent variable and connectivity measure, specifying weighted graph or binarized graph,
subject- or group-level, and the global and/or node summaries used (e.g. clustering coefficient, efficiency,
etc.).

Multivariate modeling and predictive analysis Specify independent variables, features extraction and dimension reduction, model, training and evaluation
metrics.
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